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Abstract: Parallel distributed detection system consists of several separate sensor-detector nodes (separated spatially or by their 

principles of operation), each with some processing capabilities. These local sensor-detectors send some information on an observed 

phenomenon to a centrally located Data Fusion Center for aggregation and decision making. Several techniques are developed to 

combine data from sensor – detector nodes. This article focuses on heterogeneous sensor data fusion using Dempster-Shafer evidence 

theory, which is one of the most effective approaches for sensor data fusion. The Dempster – Shafer theory of evidence has uncertainty 

management and inference mechanisms analogous to our human reasoning process. This paper describes the use of Dempster- Shafer 

theory for multi sensor data fusion and demonstrates the easiness of using Dempster Shafer engine for obtaining inference through a 

simple case study. 

 

Keywords: Data fusion, Decision making, Dempster-Shafer theory, Dempster- Shafer engine 

 

1. Introduction 
 

Data Fusion is the process of combining information from 

several different sources pertaining to the same event, 

environment or phenomenon. The field of data fusion is of 

significance in any application where a large amount of data 

must be combined, fused and distilled to obtain information 

of appropriate quality and integrity on which decisions can 

be made. Data fusion finds application in many military 

systems, in civilian surveillance and monitoring tasks, in 

process control and in information systems. In this section, 

some preliminaries of sensor data fusion and its basic 

terminologies are given. 

 

1.1 Fusion Objectives  

 

The basic intuition behind incorporating multiple 

information sources to collect information is that the 

aggregated data might be more reliable (less noisy) and 

therefore can aid in better understanding of the phenomenon 

under surveillance. Typically, the fusion objectives of a 

specific application scenario include one or more of the 

following functions:  

 Detecting presence of an object or environmental 

condition  

 Object recognition and classification  

 Target tracking  

 Health monitoring and flagging changes  

 Intelligent decision making and situation assessment  

 

If sensors used to collect observations merely duplicate 

information acquisition, the fusion process essentially 

incorporates redundancy for enhancing reliability. This 

situation might not facilitate better understanding of the 

phenomenon in question. Therefore, most multi-sensor 

fusion systems incorporate heterogeneous sensors so that a 

wide range of information with varying degrees of 

uncertainty can be collected and fused for end decision 

making.  

 

1.2 Data Fusion Architectures 

 

Set of sensors are physically distributed around  in an 

environment for sensing the phenomenon of interest. In a 

centralized data fusion system, the raw sensor observations 

are communicated to a central fusion center that solves a 

classical hypothesis testing problem and decides on one of 

the possible hypotheses.  A distinct alternative is a 

distributed  data fusion system, where each sensor has an 

associated local processor which can extract useful 

information from the raw sensor observations prior to 

communication. A summary of the local observations   (test 

statistics) is sent to the fusion center which then makes a 

decision on the basis of the messages received.   

 

Several different topologies are employed in real-world 

systems all of which fall under the umbrella of distributed 

fusion.  

 

In Parallel Decision Fusion shown in Figure 1, the local 

sensors form a bank of data collection nodes which map their 

observation vectors to local decisions. These are then sent 

forward through dedicated communication channels to the 

decision fusion center which then processes the received 

local decisions and produces a global decision on the set of 

hypotheses. 
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Figure 1: A parallel decision fusion system 

 

In Sequential or Tandem Fusion, the first sensor in the 

network uses only its own observations to compute its 

quantized data for use by the next sensor. The last sensor in 

the network acts as the fusion center and makes the final 

decision on the set of hypotheses.   

 

In Tree Structure, the sensors at the lowest level of the tree 

send their processed information to the parent sensors who 

use their own observations and the information received 

from child sensors to compute their own summarized data. 

 

1.3 Advantages of Multi Sensor Data Fusion 

 

The multi-sensor fusion system  

1) Organize data collection and signal processing from 

different types of sensor, 

2) Produce local and global representations using the 

multisensory information, and 

3) Integrate the information from the different sensors into a 

continuously updated model of the monitored system. 

 

Advantages of multi sensor data fusion are: 

 Redundancy - Redundant information is provided from a 

group of sensors or by a single sensor over time when each 

sensor observes (possibly with different fidelity), the same 

features of interest. 

 Complementarily - Complementary information from 

multiple sensors allows for the perception of features that 

are impossible to be observed using just the information 

from individual sensors operating separately. 

 Timeliness - More timely information may be provided by 

multiple sensors due to the actual speed of operation of 

each sensor, or to the processing parallelism that is 

possible to be achieved as part of the integration process. 

 Cost - Integrating many sensors into one system can often 

use many in expensive devices to provide data that is of 

the same or even superior quality to data from a much 

more expensive and less robust device. 

 

This paper is organized as follows: Section 2 presents the 

literature survey on application of Dempster shafer theory. 

Section 3 discuses on the basic principle of DST and gives 

some preliminary information. Section 4 introduces the DSE 

with a brief note on the features and the usage and presents a  

simple case study. Finally section 5 summarizes this paper 

with concluding remarks. 

2. Related work 

 

Multi-sensor data fusion techniques are widely used to meld 

data acquired by sensors deployed in the environment to 

infer the context information necessary for the 

comprehension of the environment. A comprehensive survey 

on the application of Dempster- Shafer theory for multi 

sensor data fusion is presented in this section.  

 

The authors in [1] adopts Dempster–Shafer evidence theory 

for fusing sensory information collected from heterogeneous 

sensors, assigns probability mass assignments (PMAs) to the 

raw sensor readings, and finally performs mass combination 

to derive a conclusion about the occupancy status in a room. 

In [2] the authors demonstrates  that Dempster-Shafer 

evidence theory may be successfully applied to unsupervised 

classification in multisource remote sensing. An extensive 

frame work employing Dempster-Shafer theory for fire 

detection, detection of people activity in the home and road 

traffic incident  is presented in [3], [4], [5]. In the literature 

[6], based on the obtained results, the authors discuss the 

potential contribution of theory of evidence as a decision-

making tool for water quality management. Dempster-Shafer 

approach for  sensor  data fusion  for Internet of Things 

(IoT) is reported in [7],[8]. Plenty of research work has been 

done on data fusion using other approaches like, Fuzzy 

theory, Artificial neural network, Support vector machine, 

Kalman filter and particle filter. The advantage of Dempster 

Shafer theory in handling uncertainty makes it an important 

approach for sensor data fusion.  

 

3. Sensor Fusion Using Dempster-Shafer 

Theory 
 

Demspter first introduced the well-known evidence theory 

which was later extended by his student, Shafer. This theory, 

known as DSET is mostly known to represent uncertainties 

or imprecision in a hypothesis. The hypotheses characterizes 

all the possible states of the system. These hypotheses are 

assigned a probability mass assignment (PMA) which when 

combined leads to a decision. The process of forming mass 

assignment function and combining the same is thus crucial 

for accurate prediction. DSET attains the goal of data fusion 

by means of a combination rule applied to evidence sources. 

 

3.1 Frame of Discernment 

 

It is given by the finite universal set θ which represents the 

collection of mutually exclusive and exhaustive possibilities 

or hypotheses γ1, γ2, γ3 . . . The set of all subsets of θ is 

given by its power set 2θ. Frame of discernment θ may 

include a single hypothesis (say, γ1) or a conjunction of 

hypotheses (say,γ1∩γ2). Any hypothesis γ will refer to a 

subset of θ for which sources can provide evidence.  

 

For three hypothesis γ1, γ2, γ3 

θ = {γ1, γ2, γ3} 

2θ = {φ, {γ1}, {γ2}, {γ3}, {γ1, γ2}, {γ1, γ3}, {γ2, γ3}, θ}. 

3.2 Probability Mass Assignment 

 

It corresponds to a mapping of each hypothesis γ1, γ2, γ3 . . . 

to a value m(γ ) between 0 and 1, such that: 
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1) The PMA of the null set φ is zero. In other words, belief 

cannot be assigned to an empty or null hypothesis from 

an evidence source, i.e., m(φ) = 0; 

2) Belief from the evidence sources comprising of all the 

possible hypotheses (including combinations of 

hypotheses) must sum to 1. 

i.e., m(γ1)+m(γ2)+· · ·+m( ) = 1 or  = 1. 

 

The measure m(γ ) is the degree of evidence supporting the 

claim that a specific element of θ belongs to the set γ, but not 

to any special subset of γ . 

 

 
Figure 2: An approach to determine BPA 

 

In  real  data  fusion  application  systems  based  on  DS 

theory, the basic probability  assignment (BPA) function 

should be  given  so  that  the  combined  BPA  can  be  

obtained through Dempster‟s rule of combination. 

Determination of   basic probability assignment, which is the 

main and the first step in evidence theory, is an important 

task.  There are different approaches to determine BPA. One 

such approach is given below: 

Step 1:Use  the  existing  sample  data  to  build  the normal  

distribution,  which  describe  the  model  attributes of 

instances. 

Step 2: Calculate  the  distance  measure  between  the 

collected  attribute  of  the  sample  data  and  the  model 

attribute. 

Step 3: Calculate the probability which the sample data 

belongs to the model category. 

Step 4: Normalized the probability measure to obtain the 

BPA function. 

 

3.3 Dempster-Shafer sensor fusion algorithm 

 

The Bayesian theory is the canonical method for statistical 

inference problems. The Dempster-Shafer decision theory is 

considered a generalized Bayesian theory. It allows 

distributing support for proposition (e.g., this is user A) not 

only to a proposition itself but also to the union of 

propositions that include it (e.g., “this is likely either user A 

or user B”). In a Dempster-Shafer reasoning system, all 

possible mutually exclusive context facts (or events) of the 

same kind are enumerated in “the frame of discernment”. 

 

For example, if we know that there is person in an 

instrumented room, and we want to recognize whether s/he is 

the already-registered user A, user B, or somebody else, then 

our “frame of discernment” about this person is: 

 

 

Meaning s/he is “user-A”, “user-B”, “either user-A or user-

B”, or “neither user-A nor user-B, must be somebody else”1. 

 

Each sensor, sensor  for example, will contribute its 

observation by assigning its beliefs over Θ. This assignment 

function is called the “probability mass function” of the 

sensor , denoted by . So, according to sensor ‟s 

observation, the probability that “the detected person is user. 

 

A” is indicated by a “confidence interval” 

 
 

The lower bound of the confidence interval is the belief 

confidence, which accounts for all evidence  that supports 

the given proposition “user A”: 

 
The upper bound of the confidence interval is the plausibility 

confidence, which accounts for all the observations that do 

not rule out the given proposition: 

 
 

For each possible proposition (e.g., user-A), Dempster- 

Shafer theory gives a rule of combining sensor ‟s 

observation mi and sensor ‟s observation . 

 
This combining rule can be generalized by iteration: if we 

treat  not as sensor  observation, but rather as the 

already combined (using Dempster-Shafer combining rule) 

observation of sensor and sensor . Compared with 

Bayesian theory, the Dempster-Shafer theory of evidence 

feels closer to our human perception and reasoning 

processes. Its capability to assign uncertainty or ignorance to 

propositions is a powerful tool for dealing with a large range 

of problems that otherwise would seem intractable. 

 

4. Dempster Shafer Engine 
 

4.1 Dempster Shafer Engine (DSE) Overview 

 

DSE [9] is a program that allows you to take a situation, get 

accounts from different sources, and then combine these 

accounts in a statistically accurate way. DSE implements 

Dempster Shafer theory, or The Mathematical Theory of 

Evidence, as devised by A. P. Dempster and G. Shafer. 

Important note on the terms:  Scenarios, Hypotheses, Data 

Sources, Evidence and Combining Evidence is given in this 

section. 

Paper ID: 17051902 29 of 31 



International Journal of Scientific Engineering and Research (IJSER) 
ISSN (Online): 2347-3878 

Impact Factor (2018): 5.426 

Volume 7 Issue 5, May 2019 

www.ijser.in 
Licensed Under Creative Commons Attribution CC BY 

 
Figure 3: Dempster – Shafer Engine 

 

4.1.1 Scenarios 

In DSE, a scenario collects all of the evidence, data sources 

and hypotheses together.  When you create a new document, 

you are creating a new scenario.  General scenario properties 

can be changed from the Properties item on the File menu.   

We can record the name of the scenario, who composed the 

scenario and some more general details. When a scenario is 

saved to disk using the save commands on the File menu, all 

the other information (hypotheses, data sources...) is stored 

with it. 

 

4.1.2 Hypotheses 

Hypotheses represent all the possible things that could 

happen in a scenario.    Importantly, hypotheses must not 

„overlap‟.  All the hypotheses must be unique and mutually 

exclusive. It is also important that all possible hypotheses are 

recorded.  In mathematical terms, hypotheses are elements of 

the universe of discourse, or frame of discernment. 

 

4.1.3 Data sources 

As the name suggests, a data source is a person, organization 

or some other entity that provides information for the 

scenario.  Care should be taken to ensure that sources are 

obtained that are as free from bias as possible, and in the 

case where sources are taken from a large population, that 

the sources are representative of that population. Increasing 

the number of data sources will ensure that any results 

received are of a higher quality however additional data 

sources require more computation to be performed, as well 

as more data entry. 

 

4.1.4 Evidence 

Pieces of evidence link data sources and hypotheses.  

Evidence represents how a particular data source feels about 

the outcome of a particular subset of hypotheses. Typically, 

each data source will have many pieces of evidence. When 

we are creating a piece of evidence, we are stating that we 

have some inclination to believe that the outcome of the 

scenario lies in the subset of hypotheses selected. As well as 

stating which hypotheses are involved, we must also quantify 

our belief.  We do this by assigning a probability to the piece 

of evidence.  The probability is a number between zero and 

one signifying how strongly we believe in the particular 

piece of evidence. 

To normalize probabilities: 

 Choose „Normalize Probabilities‟ from the Tools Menu.  

This menu item will only be available if there is at least 

one data source associated with the scenario. 

 If you want to normalize just the current data source, 

choose „Current Data Source‟ from the Normalize 

Probabilities Dialog.  Choose „All Data Sources‟ to 

normalize all data sources. 

 Click Ok to normalize the probabilities for the selected 

data sources.  The probabilities will be scaled so that the 

sum will be one. 

 You cannot normalize probabilities for the results view.  

Normalizing probabilities is a good idea before combining 

evidence. 

 

4.1.5 Combining Evidence 

The purpose of collecting all the pieces of evidence from the 

relevant data sources is so that we can combine all the 

conflicting evidence together to give a more coherent view 

of the probable outcome of the scenario.  This process is 

known as combining evidence.  

 

Before evidence can be combined, the sum of the 

probabilities assigned to each piece of evidence must total 

one for each data source.  This is to ensure that the evidence 

presented by each data source is equal in weight; no data 

source is more important than any other data source.  DSE 

provides the Normalize Probabilities function to ensure this 

is the case. To combine evidence: 

 Choose „Combine Evidence‟ from the Tools Menu.  This 

menu item will only be available if there are at least two 

data sources associated with the scenario. 

 The Combine Evidence Dialog will appear, and 

combination of evidence will begin.  If successful, the 

results will be displayed. 

 

4.1.6 Results 

Once the combination of evidence has completed, a new 

menu item will appear in the View menu - Results.  This 

allows the results of the combination to be viewed at any 

time.  The most probable outcomes can be viewed by 

looking at the Chart View.  You should note that once 

evidence has been combined, CURRENT will appear in the 

Status Bar.  Should you perform an action such as changing 

the probability of a piece of evidence, CURRENT will 

disappear, indicating that the results are no longer up to date.  

To see the correct results, evidence must be combined again. 

 

The combination of evidence cannot complete in the rare 

case where two data sources are in total contradiction that is 

when one data source is sure that one set of hypotheses will 

prevail, and another data source is sure that another set is the 

answer. Combination also produces the Weight of Conflict, 

displayed in the Status Bar.  This number shows how „close‟ 

the various data sources were - a result close to zero 

indicates that the data sources were in harmony, larger 

values indicate disparity. 

 

 

 

4.2 DST Application Case study 

 

In a multi sensor based automatic target recognition system, 

suppose that the targets are E1, E2 and E3. From five 

different sensors, the system collects the following data: 

Sensor 1: m1(E1)=0.41, m1(E2)=0.29, m1(E3)=0.3; 
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Sensor 2: m2(E1)=0.01, m2(E2)=0.89, m2(E3)=0.1; 

Sensor 3: m3(E1)=0.58, m3(E2)=0.07, m3(E1UE3)=0.35; 

Sensor 4: m4(E1)=0.55, m4(E2)=0.1, m4(E1UE3)=0.35; 

Sensor 5: m5(E1)=0.6, m5(E2)=0.1, m5(E1UE3)=0.3; 

Dempster Shafer theory is applied to determine the most 

probable decision on recognition of the target. The use of 

DSE for this problem is shown in the following figures and 

the outcome shows that the most probable target is E1. 

 

 
Figure 4: Sensor 4 observation 

 

 
Figure 5: Sensor 5 observation 

 

 

 
Figure 6: Outcome of sensor data fusion 

 

5. Conclusion 
 

In this paper, an approach for multi sensor data fusion 

adopting Dempster Shafer theory is explained clearly and is 

illustrated through a case study. The open source software 

DSE is employed for evaluating the outcome and the 

easiness of the usage of application software is 

demonstrated.  This article may be useful for researchers 

working in the field of Internet of Things where there is issue 

of data uncertainty.  
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